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1.0 Introduction to CD 

 
This CD-ROM contains digital data files that were assembled or created from the 2002 Glenlyon 

component of the Targeted Geoscience Initiative (TGI) project.  All data is provided in formats 

easily explored using widely available free softwares, which are distributed on this CD.  

 

Features of the CD include: 

• GIS spatial data of bedrock and surficial geology, generalized background topography, 

and georeferenced geophysical and satellite raster images 

• Interactive map projects to allow viewing and querying of the spatial data using a variety of 

common GIS software (ArcExplorer 2.0, ArcView 3.x, ArcMap 8.x, and MapInfo) 

• Databases of field observations (bedrock and surficial geology) 

• Publications relevant to the study area, including open file maps, and a collection of 

reports from the Yukon Exploration and Geology (YEG) series 

• A photo gallery to illustrate representative rock units and surficial geology features 

• Free softwares (Adobe Acrobat Reader 5 and ESRI ArcExplorer 2) for viewing publications 

and interactive maps 

 

Navigation to the features described above is through a user-friendly interface which launches 

upon loading of the CD.  All features can also be accessed through Microsoft Explorer. 



 

1.1 Software and System Requirements 

 

The GIS data provided on this CD is in shapefile format which can be easily viewed using most  

commercial GIS softwares (ArcView 3.x, ArcMap 8.x, Mapinfo, or AutoCAD Map).  This data can 

also be viewed with ESRI’s ArcExplorer free GIS software (ArcExplorer 2 is included on this 

CD). Installation of ArcExplorer (or ownership of a licensed version of one of the more advanced 

GIS products listed above) is required to view the interactive maps on this CD.   

 

Field databases are provided in Microsoft Access and Excel formats, as well as dBase (*.dbf) 

files. These data can be viewed with licensed copies of Microsoft Access and Excel or through 

the interactive maps. 

 

The documentation, and published maps and reports are provided as PDF files. Installation of 

the free Adobe Acrobat Reader (or ownership of a licensed version) is required to view these 

files (Adobe Acrobat Reader 5 freeware is included on this CD).   

 

This CD runs on Windows 95 platforms and higher, and has been tested on Windows 98, 2000, 

NT and XP.  Performance times for use of the interactive maps will depend on individual 

hardware componentry and memory availability.  It is therefore recommended that users copy all 

data onto a local hard drive for greater speed in accessing and displaying the spatial data. 



 

 

1.2 Getting Started 
 

The CD-ROM contains an “AutoRun” routine which will launch the interface or Home panel (shown below).  If 

AutoRun is disabled on your computer or the home panel does not appear automatically, the interface can be 

loaded by running the GlenlyonCD.exe file manually using Windows Explorer.  

 

The Home panel provides navigational links 

to the various features of this CD-ROM. The 

buttons on this panel allow the user to access 

other panels from which you can view 

Interactive Maps, field observation 
Databases, map and report (Publications), a 

collection of Photos of representative bedrock 

and surficial stations and samples from the 

area, and a help guide (this document) for the 

use of this CD (Manual). Additional buttons 

provide access to a Read Me file and the CD 

directory structure using Windows Explorer 

(Explore CD). 

 

Free Installation files for required data viewing 

software can be accessed by clicking the Interactive Maps button (for ArcExplorer 2.0) or the Publications button 

(for Adobe Acrobat Reader 5).



 

1.3 Directory Structure 
 The data on this CD are organized into three main folders, as shown on the left. 

 

All GIS spatial data, databases, raster images and photos are in the Data 

folder. 

 

All published maps and reports in Adobe Acrobat Reader format are in the 

Publications folder. 

 

The Software folder contains free ArcExplorer installation files for viewing 

interactive maps, and Adobe Acrobat Reader installation files for viewing 

published maps and reports.  A free hyperlinking extension for ArcView 3.x to 

enable opening of photos and reports interactively within ArcView is also 

included.  Finally, a copy of GeoFIELD, the Yukon Geology Program’s Access 

field database is also included.  GeoFIELD can be used to manage and store 

field data, as well as plot stations and structural symbols interactively in 

AutoCAD Map.  

 

NOTE:  Through this manual, all references to the root directory refer to the 

Glenlyon CD folder.  All path names written in this document are written in 

italics and use two dots to represent (..) the root directory.  For example, if a file 

name is given as “..data\gis_projects\esri\bedrock.mxd”, it is located at 

“Glenlyon_CD\data\gis_projects\esri\bedrock.mxd”. 

  



 

1.4 GIS Spatial Data Formats 
 

The GIS spatial data formats on this CD include ESRI shapefiles, MapInfo tables, raster images, and Access 

databases.   

 

The projection of all spatial data contained on this CD is the Universal Transverse Mercator (UTM) coordinate 

system, NAD 83 datum, Zone 8. 

 

1.4.1 VECTOR DATA: 

 

Shapefiles can be used in all of ESRI’s GIS software, and can be easily imported into other GIS formats 

such as MapInfo and AutoCAD.  One shapefile can be comprised of up to 9 different files of the same 

name, but with different extensions (*.shp, *.dbf, *.sbn, *.sbx, *.shx, *.xml, *.avl, *.lyr, *.prj).  When moving 

or copying a shapefile, all of these files must be moved or copied together.  For ArcView 3.x users, 

accompanying legend files (*.avl) are included, and for ArcMap users layer (*.lyr) and projection (*.prj) 

files are also included so that symbology can be reproduced in custom map projects built from scratch. 

 

Mapinfo table files are also included.  These were created by importing the ESRI shapefiles into table 

format using MapInfo’s Universal Translator.  Like shapefiles, a MapInfo table is comprised of up to 5 

separate files of the same name, but with different extensions (*.tab, *.map, *.ind, *.id, *.dat).  When 

moving or copying a table, all of these files must be moved or copied together. 

 



 

… 1.4 GIS Spatial Data Formats 

 

1.4.2 RASTER DATA: 

 

Geophysical and satellite raster data is provided in *.jpg image format, with associated world files (*.jgw) 

for proper georeferencing.  Pyramid files (*.rrd) and auxiliary files (*.aux) are included for faster 

regeneration within ArcMap 8.x.  The JPEG extension must be activated when viewing the raster data 

within ArcView 3.x.  ArcMap and ArcExplorer will read the rasters directly.  Table files (*.tab) are also 

included for referencing the rasters in MapInfo. 

 

 

1.4.3 ACCESS DATABASES: 

 

ArcView 3.x, ArcMap 8.x and MapInfo can read data from an Access database.  In ArcView 3.x, use SQL 

connect to access the database.  In ArcMap 8.x, use database connections.  If spatial data is present as 

coordinates in a table or query, an “event theme” can then be created to plot point data from the 

databases.  If no spatial data is present in the table, non-spatial attribute data can be joined or related to 

existing shapefiles. 

 

 

 

 

 



 

 

2.0 Geological Summary 

This CD-ROM contains the results of an Accelerated Bedrock Mapping and Till Geochemistry 

program of parts of Glenlyon (105L/1-7, 11-14) and northeast Carmacks (115I/9,16) map areas. 

The field program was conducted between June 15 and July 19, 2002 under the auspices of the 

Yukon Targeted Geoscience Initiative (TGI - Integrated geoscience mapping for Yukon: 

NATMAP enhancement ), a joint program that combined geologists and funding from the 

Geological Survey of Canada and the Yukon Geology Program. It was designed as an 

enhancement to the Ancient Pacific Margin NATMAP project. This program followed a previous 

Accelerated Bedrock Mapping and Till Geochemistry program in the Finlayson Lake map area 

(Bond et al., 2002). 

 

The Glenlyon project aimed at extending the bedrock mapping of Yukon-Tanana Terrane from 

areas of detailed mapping in southern and northwestern Glenlyon (105L1,2,7,13) to intervening 

poorly exposed grounds. The till geochemistry coverages was conducted to supplement the low 

density of stream geochemistry samples in the area 

 

The centre of the area is underlain by prospective rocks of Yukon-Tanana terrane (host of the 

Finlayson Lake district massive sulphide deposits). Yukon-Tanana terrane is flanked to the 

northeast by rocks of Ancestral North America (Cassiar terrane) and to southwest by the 

enimagtic Semenof block.



 

Glenlyon – NE Carmacks area (105L / 115I)



 

2.1 Bedrock Mapping 
In 2002, Yukon Geology Program joined once again 

with the Geological Survey of Canada to fund and 

implement the last year of the Yukon Targeted 

Geoscience Initiative (TGI). The 2002 program 

focussed on completing a new bedrock geological 

map of parts of Glenlyon (105L) and eastern 

Carmacks (115I) map areas (Colpron et al., 2002). 

Under the auspices of the TGI, personnel from both 

organizations worked for five weeks with a contract 

helicopter out of a base camp near Tatchun Lake. 

The intent of the TGI was to determine the regional 

extent of Carboniferous volcanic rocks of Yukon-

Tanana Terrane, which have potential for volcanic-

hosted massive sulphide deposits, and their local 

basement. The Glenlyon area lies along regional 

trend to the south of the Finlayson Lake district 

when ~425 km of dextral displacement is restored 

along Tintina Fault. The TGI also aimed at 

determining the nature of the contact between 

Yukon-Tanana and Cassiar terranes, and the 

composition of volcanic rocks at the northern end of 

the Semenof block (Tempelman-Kluit, 1984) and 

their relationship to Yukon-Tanana Terrane.  

 

This CD-ROM contains the digital data collected in 

the field and generated during the production of the 

new bedrock map. Description of the field 

relationships can be found in Colpron et al. (2003). 

Previous studies 

Geological observations from the area were first 

reported by Dawson (1888) who travelled along the 

Pelly River in 1887. In 1902, McConnell (1903) 

explored the Macmillan River. In 1928, Cockfield 

(1929) made a geological reconnaissance of the 

Little Salmon and Magundy valleys. The Pelly River, 

upstream from the mouth of the Macmillan River, 

was revisited in 1935 by Johnston (1936). Between 

1932 and 1949, H.S. Bostock was engaged in 

mapping the areas surrounding the Glenlyon map 

area – including Carmacks (115I) to the west 

(Bostock, 1936), Laberge (105E) to the south 

(Bostock and Lees, 1938), Mayo to the north 

(Bostock, 1947), and McQuesten (Bostock, 1964).  

Reconnaissance mapping of the Glenlyon 

map area (105L) was not conducted until the early 

1950s (Campbell, 1967). Carmacks and Laberge 

map areas were the object of a second generation of 



 

reconnaissance mapping by Tempelman-Kluit 

(1984). In Glenlyon, only limited detailed structural 

studies (Oliver, 1996; Oliver and Mortensen, 1998) 

were conducted since the area was first mapped by 

Campbell (1967).  

Current study 

Systematic detailed bedrock mapping of the 

Glenlyon map area (105L) was initiated in 1998. 

Between 1998 and 2001, 1:50 000-scale mapping 

focused on areas of better exposures in northwest 

Glenlyon map area (105L/13; Colpron, 1998; 1999a) 

and near Little Salmon Lake, to the south 

(105L/1,2,7; Colpron, 2000; Colpron and Reinecke, 

2000; Gladwin et al., 2002a). This detailed mapping 

has defined the stratigraphic framework of Yukon-

Tanana Terrane in the area. In particular, it has 

identified successions of Carboniferous arc volcanic 

rocks, associated plutonic suites of Mississippian 

age, and their potential basement complex (Colpron, 

2001). This work also uncovered indications that 

hydrothermal systems capable of producing 

volcanogenic massive sulphide deposits operated 

during volcanism, including a small massive sulphide 

occurrence (Yukon MINFILE 105L 062; Colpron, 

1999b) and occurrence of Mn chert exhalite in the 

Little Salmon formation. This detailed work lay the 

foundation for regional, helicopter-supported 

bedrock mapping in poorly exposed areas of 

Glenlyon and northeastern Carmacks map area 

during the 2002 summer. 

Bedrock geology (Colpron et al., 2003) 

The study area extends from displaced North 

American miogeoclinal strata of Cassiar Terrane in 

the northeast to the accreted arc volcanic and clastic 

rocks of Stikine Terrane in the southwest (Colpron et 

al., 2002). The core of the area is underlain by a 

northwest-trending belt of metasedimentary, 

metavolcanic and (meta)plutonic rocks of the Yukon-

Tanana Terrane. To the southwest, Yukon-Tanana 

Terrane is juxtaposed with the Semenof block – a 

belt of mafic metavolcanic rocks of uncertain terrane 

affinity (Tempelman-Kluit, 1984) – along the 

Needlerock and Big Salmon faults. To the northeast, 

the Tummel fault zone delineates the contact 

between Yukon-Tanana and Cassiar terranes. The 

narrow belt of chert, argillite and greenstone which 

occurs within the Tummel fault zone probably 

correlates with the Slide Mountain Terrane. The area 

is intruded by Early Jurassic and Cretaceous plutons 

and is dissected by a series of late faults.  



 

Bedrock Geology Map parts of Glenlyon (105L) and Eastern Carmacks (115I) 

 

mcolpron
Grey shaded areas show areas of 1:50 000-scale mapping



 

 

2.2 Till Geochemistry (modified from Bond and Plouffe, 2003) 
In continuing the program of bedrock mapping and 

till geochemistry across prospective tracks of Yukon-

Tanana Terrane (YTT) the TGI focus shifted 

northwest towards the Glenlyon map area.  Last 

year, TGI efforts were focused in the Finlayson Lake 

region where a large tract of YTT remained poorly 

mapped amidst high mineral potential.  The geology 

of the Glenlyon map area was suspected to mirror 

the Finlayson Lake district following restoration of 

425 km displacement along the Tintina Fault.  While 

the geological relationship seemed favourable in the 

Glenlyon region, vast areas of poorly understood 

geology are blanketed by glacial deposits.  

Furthermore, drainage is poorly developed in the 

plateau region of the Glenlyon map area which is 

reflected by a low sample density of regional stream 

sediment geochemical data. Similar to the Finlayson 

project, till was favoured as a sampling medium for 

the following reasons: 1) it occurs abundantly on 

plateaus and hills in areas of poor bedrock 

exposure; and 2) it is considered a first-order 

derivative of bedrock (Shilts, 1976, 1993). 

Previous studies 

Quaternary stratigraphic investigations and surficial 

mapping were completed by Ward (1989; 1993), 

Ward and Jackson (1992; 2000) and Jackson (2000) 

for the Glenlyon and eastern Carmacks map areas.  

Surficial geological mapping was completed at 

1:100,000 scale for both areas and provided the 

background for this work.  Related studies to the 

north of Glenlyon and Carmacks map areas include 

surficial mapping by Hughes (1982) in Mayo (105M) 

and placer gold deposit studies in the Mayo mining 

district (LeBarge et al., 2002).  Surficial mapping and 



 

Quaternary stratigraphy investigations were 

undertaken in McQuesten (115P) to the northwest 

(Bond, 1997).  More recently, a drift prospecting and 

surficial mapping study was completed to the east in 

the Anvil district (Bond, 2001).   

Sampling and analytical methodology 

A total of 3 samples were collected at each till 

sample station.  This included a 2-kg and a 1-kg bulk 

till sample for geochemical analysis of the silt plus 

clay-size fraction (-230 mesh or <0.063 mm) and the 

clay-size fraction (<0.002 mm), respectively.  The 

third sample consisted of a lithological record 

comprising 50 pebbles.  Lodgement till and 

colluviated lodgement till was the primary sample 

medium.  Each till pit was hand-dug to a depth 

averaging 50 cm in order to collect till from the C-

horizon (unweathered parent material.  Where 

possible, till was sampled from natural exposures 

during stratigraphic investigations.  This is beneficial 

when thick till deposits are encountered and enables 

assessment of the vertical variability of the till 

geochemistry. 

The till samples were sent to Acme Analytical 

Laboratories in Vancouver, British Columbia for: 1) 

separation of the silt and clay-size fraction (2-kg 

sample) and 2) geochemical analysis.  Samples 

were oven dried at 40 celcius and dry-sieved to 

separate the silt and clay-size fractions (<0.062 mm 

or -230 mesh).  Samples of 30 g were analysed for 

39 elements by inductively coupled plasma mass 

spectrometry (ICP-MS) after an aqua regia 

digestion.  The digestion acts as a near total 

digestion on sulphide minerals and a partial leach on 

silicate minerals.  Results of the geochemical 

analyses of the clay-size fraction were not available 

at the time this was prepared, but will be released in 

a later publication together with the 2001 clay-size 

results (see Bond and Plouffe, 2002).  



 

2.3 Crew 

Bedrock Mapping: 

Geologists:   

Maurice Colpron Yukon Geology Program (Yukon Government) Maurice.Colpron@gov.yk.ca 

Don Murphy Yukon Geology Program (Yukon Government) Don.Murphy@gov.yk.ca 

Charlie Roots Geological Survey of Canada (Whitehorse) Croots@NRCan.gc.ca 

JoAnne Nelson 
 

British Columbia Geological Survey (Victoria) 
 

joanne.nelson@gems1.gov.bc.ca 

Steve Gordey Geological Survey of Canada (Vancouver) Sgordey@NRCan.gc.ca 

Grant Abbott 
 

Yukon Geology Program (Indian and Northern Affairs Canada) Abbottg@inac.gc.ca 

Kaesy Gladwin University of Victoria (Victoria) 
 

kaesy@uvic.ca 

Till Sampling: 

Surficial Geologists:  

Jeff Bond Yukon Geology Program (Indian and Northern Affairs Canada) Jeff.Bond@gov.yk.ca 

Alain Plouffe Geological Survey of Canada (Ottawa) aplouffe@ NRCan.gc.ca 

Geological Assistants:  

Robbie Cashin Carmacks  

Guy Buller Geological Survey of Canada (Ottawa)  

GIS / Digital Cartography: 

Panya Lipovsky Yukon Geology Program (Yukon Government) Panya.Lipovsky@gov.yk.ca 

Amy Stuart Yukon Geology Program (Yukon Government) Amy.Stuart@gov.yk.ca 



 

… 2.3 Crew 

Camp Logistics: 

Camp Manager: Joe Haggett Volunteers: Tony Wass, Bruce Skea, Barrett Mattesee 

Cook: Eileen McKie   

Helicopter Crew: 

Fireweed Helicopters   

Pilots: Jock Mackay, Jon Pellow  

Apprentice: David West  

Security and Comic Relief: 

 Topaz, Belle, Jasper, Keno,  Ruby and ol’ Kaleb 
 

mcolpron
The 2002 Glenlyon TGI crew
(from left to right): Charlie Roots, Kaesy Gladwin, Amy Stuart, Jock Mackay, Alain Plouffe, Robbie Cashin (foreground), Don Murphy (with dog, Belle), David West (in door), Guy Buller, Grant Abbott, Eileen McKie, Steve Gordey, JoAnne Nelson, Maurice Colpron (with dog, Ruby), Robin Black, Joe Haggett, Jeff Bond (with dog, Keno). 
Missing: Panya Lipovsky.



 

3.0 Interactive Maps 

 

Interactive map projects are provided in four different GIS software formats: 

 

1) ESRI ArcExplorer (*.aep)  

2) ESRI ArcView 3.x (*.apr)  

3) ESRI ArcMap 8.x (*.mxd) 

4) MapInfo (*.wor) 

 

Any one of these four software 

products must be installed on your 

computer in order to view an 

interactive map from the CD.  Free 

ArcExplorer 2.0 installation files are 

included with this CD.  For first time 

users, ArcExplorer  is an easy to 

learn, intuitive GIS map viewer with a reasonable range of capabilities.  MapINFO, ArcView 3.x 

and ArcMap 8.x allow more powerful GIS analysis and querying capabilities, but must be 

purchased. 

 

See the following sections for information regarding each software type. 



 

…3.0 Interactive Maps Projects 

Five projects are available for viewing in the four GIS software formats described above.   

 

The same data is included in each of the five projects project, but different layers are made visible in order to 

save set up time for the user.  Each project provides a starting point for browsing and querying the data, or from 

which customized thematic maps can easily be created.  (To show legends for layers that have been minimized 

in a project, select the theme, and choose “hide/show legend” from the theme menu in ArcView.  In ArcMap, 

simply click the “+” sign next to the layer name.) 

 

Data from other sources (i.e. more detailed topography, private spatial data covering the same area, or data 

from the internet) can also be added to the maps, provided they are in the same projection. 

 

To view the maps in any of the formats, click on Maps, and select the software you wish to use.  Then select 

which map type to view and press the Open button.  

   

 
 

 

 

 

 

 

 

 

Map Project Name Initial Display: 

(1) bedrock (.aep,apr,mxd,wor) Bedrock geology map, structural symbols,  fossils, geochronology and  
Yukon MINFILE overlain on 1:1 000 000-scale topography  

(2) geophysics (.aep,apr,mxd,wor) Bedrock geology contacts and faults overlain on total field aeromagnetic 
image (from Geological Survey of Canada) 

(3) geochem (.aep,apr,mxd,wor) Till geochemistry with gold results overlain on 1:1 000 000 scale topography; 
other elements can be turned on or off as desired. 

(4) surficial (.aep,apr,mxd,wor) 

 
Surficial photo locations, and till clast lithology data overlain on surfical 
geological map (from Ward & Jackson, 1993)   
 

(5) rgs (.aep,apr,mxd,wor) Regional geochemical survey (RGS) data overlain on 1:1 000 000 scale 
topography. 
 



 

 

 

IF YOU CAN NOT OPEN A MAP PROJECT: 

 

• If you attempt to open an interactive map project with GIS software that is not installed on your 

computer, the following error message will appear: 

 

 
 

 

Press OK, and choose the correct viewing software, or if you have none, install ArcExplorer 2.0. 

 

 

 

• If you have the GIS software already installed on your computer, and the project will still not open 

from the interface, check your Windows file associations in Windows Explorer (For Windows XP, 

Go to Tools > Folder Options > File Types, and scroll through the list of extensions.)  AEP files 

must be associated with ArcExplorer, APR files must be associated with ArcView 3.x, MXD files 

must be associated with ArcMap 8.x, and WOR files must be associated with MapInfo.  

 



 

 

3.1 ArcExplorer 2.0 

To install ArcExplorer   2.0, click on Maps, and choose “Install ArcExplorer” in lower right 

of the window.  Follow the set up instructions on the screen and install the free software wherever desired on 

your hard drive.  Consult the included ArcExplorer   help files for detailed instructions on how to use 

ArcExplorer.  Further information, support and software updates are available from the ESRI website: 

http://www.esri.com/software/arcexplorer/index.html. 

 

Five ArcExplorer  projects (*.aep) are provided as interactive GIS maps.  The projects were created in 

ArcExplorer   version 2.0, but should be compatible with any version of ArcExplorer  .  To open the projects, 

use the Interactive Maps panel from the home interface, or start ArcExplorer , select Open Project from the 

File menu and choose one of the five projects (*.aep located at ...\data\gis_projects\esri).  Each of the five 

ArcExplorer  projects contains the same data, but different layers are made visible.  The projects provide 

starting points for data viewing and the creation of customized thematic maps.   

   

A total of 81 themes (or layers) are listed with their corresponding symbology in the legend at the left side of the 

map window, in the legend bar.  You can widen the legend bar if some of the legend text is cut off by placing the 

mouse over the right edge of the legend, and dragging to the right when a horizontal arrow icon is displayed.  

Turn themes on and off by clicking the check box to the left of the theme name.  Experiment with displaying 

different combinations of themes.  Use the Map Tips and Identify tools to explore the attribute data for individual 

features, or use the Query Builder tool to highlight multiple features in an active theme that meet custom criteria.  

You can print your map window, but only at the scale and extent visible on the screen, and you can not 

customize the layout. 

 

http://www.esri.com/software/arcexplorer/index.html
http://www.esri.com/index.html


 

ArcExplorer  Tips and Tricks 

 

For first time users, a few of the most useful functions of ArcExplorer  are highlighted below.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

…ArcExplorer  Tips and Tricks 

 

1) Active Theme:  The layer that appears raised in the legend is the active theme.  Click on 

a layer to make it the active theme.  The active theme is reported in the bottom right corner of the 

map window (in the above figure, the active theme is TILL_GEOCHEM – AG.)  Many of 

ArcExplorer’s viewing capabilities take effect for the active theme only. 

2) Scroll Themes: Scroll through the themes with the small arrow buttons in the top right 

 and bottom left corners  of the layer window.  The solid scrolling arrows scroll very quickly 

through the list, which the hollow arrows scroll slowly.  

3) Pan and Zoom:  Use the pan and zoom tools  to move around the map.  Zoom 

to the entire extents of the map , or zoom to the extents of a particular theme .  You can 

also use the scroll bars at the right and bottom of the map to move around the map.  

4) Overview Map:  An overview map is shown in the bottom left corner of the map window, 

with the outline of the entire study area, and a red box showing the extent of the map window that 

is currently visible on your screen.  You can move the red box around with the hand to pan the 

main map window.  If the overview map is not visible, make the “Neatline” theme active, go to the 

“Theme” menu, and choose “Use in Overview Map”.   

 



 

…ArcExplorer  Tips and Tricks 

5) Scale:  The scale is shown at the bottom of the window in three formats, as a numeric 

proportion, a textual representation, and as a visual scale bar. 

6) Measure tool:    Click the arrow at the side of the ruler to select the desired 

measuring units (m, km, ft, or miles), then draw a line segment on the map and see the measured 

distance in the top left corner of the map window.  If you make another measurement, the 

cumulative distance will be reported, as well as the individual segment distance. 

7) Location:  As you move the cursor around the map, the coordinates (UTM location in 

meters) are displayed in the bottom left corner of the map window. 

8) Map Tips:   A value identifying a feature will be displayed when the mouse pointer 

passes over a feature contained in the active theme, regardless of what tool is selected.  A map 

tip field has been pre-set for each layer.  You can change what data is shown by activating a 

theme, clicking the map tips button, and selecting a new 

field to display.   

For example, with the “Till_geochem – Ag” theme 

active, you could display the gold results in your map tips, 

instead of the default silver results, by choosing the 

AU_PPM field from the list shown at the right.  This would 

allow you to see where the relative silver highs are on the 

map, while at the same time quickly being able to review 

gold values by passing the mouse over the sample points.       

 



 

…ArcExplorer  Tips and Tricks 

9) Identify tool:   Click on a feature in the active theme to bring up the Identify Results 

window showing all attribute data describing that feature.  The location that you clicked is 

displayed in the top left of the window.  You can change the dimensions of the Identify Results 

window to see all the data.  Click on the “Field” label to sort the fields alphabetically.  If you click 

on more than one feature at once, all the features will be listed at the left, under the Feature 

column, and you can select which feature’s attributes to view.  Close the Identify Results window 

when you are finished examining the attribute data. 

 

You can drag and drop the results of an Identify into Microsoft Word or Excel. With the left mouse 

button, click one of the data fields listed in the Identify Results window.  Then, drag and drop into 

the application of your choice. 

 

10) Query tool:  A query expression is a precise definition of what you want to select 

and highlight on your map.  You can only query the attribute data of the active theme.  See 

ArcExplorer’s help files for detailed information on building queries.  Building a query expression is 

a powerful way to select features because an expression can include multiple attributes, 

operators, and calculations.  For example, you could query a till geochemistry theme for samples 

that exceeded a certain amount of lead, and a certain amount of zinc.  You could then zoom in on 

your map to the query results, or you could also drag and drop the results of the query into 

Microsoft Word or Excel. 

 



 

3.2 ArcView 3.x Projects 
 

Five ArcView 3.x projects (*.apr) are provided as interactive GIS maps.  The projects were created in 

ArcView  version 3.2, but should be compatible with any version of ArcView 3.x.    To open the projects, use 

the Interactive Maps panel from the home interface, or start ArcView 3.x, select Open Project from the File 

menu and choose one of the five projects (*.apr located at ..\data\gis_projects\esri).  Attempting to open these 

projects by double-clicking the file in Windows Explorer may not work properly.  If a message box asks “Where is 

…AV_GIS30\ARCVIEW\ext\hotlinkapi.avx?” hit cancel, and the project will open.  (See next section to resolve 

this issue.)  

 

Each of the five ArcView  projects contains the same data, but different layers are made visible.  The 

projects provide starting points for data viewing and the creation of customized thematic maps.  A total of 

82 themes (or layers) are available for display and analysis. 

 

For full functionality, the ArcView  projects must be opened from the CD; if the CD file structure has been 

copied to your hard drive, then the “Glenlyon_CD” folder (containing all the data from the CD) must be found in a 

root directory (i.e. immediately after the drive letter1).   

  Legend Symbology: 

Legend files (*.avl) are included with each shapefile to allow reproduction of symbology in projects built from 

scratch or where Glenlyon shapefiles are added to pre-existing projects. 

                                                                                                                                                                
1 For example, the ArcView project file (*.apr) must be located at: DRIVELETTER:\Glenlyon_CD\maps\Shape_Files\bedrock.apr, 
where DRIVELETTER is either your CD-ROM drive, or a hard drive letter to which all the data has been copied. 

 



 

 Hyperlinking in ArcView 3.x 

Hyperlinking (or hotlinking, as it is called in ArcView) allows the user to click on a map feature and 

open an associated document (for example, a report or a photo.)  With the ArcView projects provided, 

you can hyperlink on three themes: MINFILE – hyperlink, Bedrock Photos – Hyperlink and Surficial 
Photos – Hyperlink. 
 

To make use of this capability,  

(1) Adobe Acobat Reader must be installed on your computer (free files provided on this CD-

ROM or available at www.Adobe.com); and  

(2) the extension, HOTLINKAPI.AVX (provided on this CD-ROM1) must be copied into the 

ArcView extensions folder (..\ESRI\AV_GIS30\ARCVIEW\EXT32), which is located where ArcView  

is installed on your machine.  This is a very small file (16 kb).   

 

When you click on a MINFILE occurrence with the Hotlink tool in ArcView, HOTLINKAPI will open a 

summary report describing the mineral occurrence in Adobe Acrobat Reader.  If you click on more 

MINFILE occurrences with the hotlink tool, their reports will be opened on top of the previous ones.  The 

previous files will not be closed in Acrobat Reader; you must close the reports manually, or exit Acrobat 

Reader.  When you click on a photo with the Hotlink tool,   HOTLINKAPI will open the photo in whichever 

image editing software Windows associates with JPEG files on your machine (this could be Adobe 

Photoshop, Corel PhotoPaint, or Microsoft Photo Editor.) 

                                                                                                                                                                
This extension uses the Windows API (Application Programming Interface) to open a file with the program that Windows associates with its extension. 
Portions of this work include intellectual property of Mel VanderWal and are used herein with permission.  Mel VanderWal (2002). All rights reserved. 

 

http://www.adobe.com/products/acrobat/main.html?awe_3010


 

3.3 ArcMap 8.x Projects 

Five ArcMap 8.x projects (*.mxd) are provided as interactive GIS maps.  The projects were created in 

ArcMap  version 8.2, but should be compatible with any version of ArcMap 8.x.  To open the projects, 

use the Interactive Maps panel from the home interface, or start ArcMap 8.x, select Open Project from 

the File menu and choose one of the five projects (*.mxd located at ..\data\gis_projects\esri).  Each of 

the five ArcMap projects contains the same data, but different layers are made visible.  The projects 

provide starting points for data viewing and the creation of customized thematic maps.  A total of 82 

themes (or layers) are available for display and analysis. 

Legend Symbology: 

Layer (*.lyr) files are included with each shapefile so that symbology can be reproduced in map projects built 

from scratch, or where the Glenlyon shapefiles are added to pre-existing personal map projects.  Projection (*.prj 

files are found in an arcmap_projections subfolder, found one level below the shapefiles.  They are not included 

in the same folder as the shapefiles as this adversely affects the performance of the ArcExplorer projects.  If you 

will be viewing the shapefiles using ArcMap, and will not be using ArcExplorer, the projection files should be 

copied into the same folders as the shapefiles so that ArcMap can recognize the projection.  

Hyperlinking in ArcMap:                                                                                         

Select the hyperlink button  (the yellow lightning bolt), and all features with valid hyperlinks will be shown 

with a blue dot in the middle of their symbology.  When you pass the hyperlink tool exactly over a blue dot, the 

hyperlink icon will change to a hand icon, and the path to the hyperlinked file will be displayed.  With the hand 

icon, click on the hyperlinked feature, and the file will be opened using the appropriate software (Acrobat Reader 

for the MINFILE – Hyperlink layer, and whichever application Windows uses as a default photo viewer, for the 

Photos – Hyperlink layer.)  If more than one document is hyperlinked at a single point, a window will list all 

available documents and you must choose which one to open.    



 

3.4 MapInfo Workspaces 
 

Five MapInfo  workspaces (*.wor) are provided as interactive GIS maps.  The workspaces were 

created in MapInfo  version 5, but should be compatible with any version of MapInfo.  To open the 

workspaces, use the Interactive Maps panel from the home interface, or start MapInfo , select Open 

Workspace from the File menu and choose one of the five workspaces (*.wor located at 

..\data\gis_projects\mapinfo).  Each of the five MapInfo  projects contains the same data, but different 

layers are made visible.  The projects provide starting points for data viewing and the creation of 

customized thematic maps. A total of 38 themes (or layers) are available for display and analysis. 

 

Legend Symbology: 

MapInfo  theme template files (.thm) have been provided for the bedrock and surficial geology layers, so that 

symbology can be reproduced in workspaces built from scratch, or where the Glenlyon tables are added to pre-

existing workspaces.  To load the theme templates, go to the Options menu, select Preferences, then choose 

the Directories, and under Theme Templates navigate to the theme template folder 

(..data\gis_projects\mapinfo\theme_templates).  Alternatively, copy the *.thm files into your 

..\MapInfo\THMTMPLT folder where MapInfo   is installed on your harddrive, and this will add the Glenlyon 

templates to the list of default templates. 

 

When creating a thematic map, choose type Individual 
and the various Glenlyon templates will be listed to choose 

from.  The custom theme templates provided, and the 

tables and fields that should be used with each are listed 

at the right: 

TEMPLATE NAME TABLE FIELD 
Glenlyon_Geology  geology mapunit 

Glenlyon_bedrock_1999_YDG geology_ydg tgi_unit 

Glenlyon_surficial_geology surf_geol class 

Glenlyon_Contacts contacts reliabilit 

Glenlyon_Faults  faults reliabilit 



 

 

InfoTips: 

 

Like ArcExplorer MapTips, MapInfo’s InfoTips display a value identifying a map object when the cursor is passed 

over the object.  InfoTips are activated by the Select tool, Label tool and the Info tool.  Each table layer can have 

a specific InfoTip for display, but the InfoTip for the topmost selectable layer will always be shown first.  To see 

the InfoTips for a particular layer, move that layer to the top in the Layer Control dialogue. 

 

3.5 AutoCAD Map 
 

While no data on the CD is provided in AutoCAD Map  *.dwg format, shapefiles and their attribute tables can 

be quickly and easily imported into AutoCAD Map .   

 

Go to the Map menu, select Tools > Import, choose ESRI Shape under Import Type, and browse to the 

appropriate folder where the shapefiles are found.  Check the desired shapefiles, specify a layer name for each 

shapefile (the default layer name is the same name as the shapefile).  The default settings will not import 

attribute data, but you can select all or some specific fields if you wish to import the attribute data as object data.



 

 

4.0 Theme Descriptions 

This section lists the themes (ESRI shapefiles and MapInfo  tables) that are available for viewing in the 

interactive map projects along with accompanying metadata (source, description, scale) and summaries of 

attribute data.  There are 82 available themes, which can be subdivided into the following categories based on 

subject matter and data source: 

 

In the following tables, theme name refers to the name displayed in the legend of the interactive map projects; 

file name refers to the name of the shapefile or MapInfo table which underlies a theme, ArcExplorer Map Tip 

refers to the value displayed when a tool passes over a feature in the active layer of ArcExplore (or a feature in 

the topmost layer in MapInfo) and attribute data summarizes data associated with each feature which may be 

useful for queries or searches. 

Theme Category Themes Scale Source 

4.01) Bedrock Field Database 5 1: 50 000 YGP Field Data Collection - GeoFIELD database 

4.02) Bedrock Geology 10 1: 125 000 YGP Open File 2002-9 

4.03) Yukon MINFILE 1 1: 250 000 YGP Yukon MINFILE 2002 

4.04) Isotopic Age Date 1 1: 250 000 YGP, Updated from Yukon Digital Geology, 1999 

4.05) Fossil Collections 1 1: 250 000 YGP, Updated from Yukon Digital Geology, 1999 

4.06) Surficial Geology Field Data 3 1: 50 000 YGP Field Data Collection – Surficial database 

4.07) Surficial Geology Map Units 1 1: 100 000 GSC Maps 1786A-1789A, 1878A, 1879A 

4.08) Till Geochemistry 40 1: 50 000 YGP Laboratory results 

4.09) Regional Geochemical Survey 1 1: 50 000 GSC / YGP 

4.10) Topographic Features 3 1: 1 000 000 ESRI Digital Chart of the World 

4.11) Base Map Layers 7 1: 50 000 YGP / NRCan / Yukon Environment 

4.12) Geophysical Images 7 30 m resolution GSC / YGP 

4.13) LandSat Images 2 15 m resolution Geomatics Yukon / YGP 



 

 

4.01 Bedrock Field Database Themes 
 

These five point themes represent the locations of field observations and sample collections taken in the 

study area since 1998.  The shapefiles were derived from the bedrock geology GeoFIELD database 

(..\data\databases\ms_access\field_data\bedrock_geol\bedrock.mdb).  All locations were derived from 

GPS readings of UTM coordinates, with an accuracy on the order of 10 m. 

 

The bedrock database theme shapefiles are found in the..\data\gis_projects\esri\bedrock_geol folder.  

The corresponding MapInfo tables are found in the ..\data\gis_projects\mapinfo\tables folder. 

 
 

Theme Name File Name 
(*.shp, *.tab) 

ArcExplorer 
Map Tip 

Description Attribute Data 

     
Bedrock Stations 
 

stations station number Location of field stations (points) 
 

UTM coordinates (NAD83), nts sheet, 
geologist, station number, date, elevation 
 

Bedrock Photos - 
Hyperlink 
 

photos_hyper caption Location of field photographs, with 
active hyperlinks in ArcView 3.x 
and ArcMap 8.x (points) 
  

station number, caption, UTM coordinates 
(NAD83), photographer, hyperlink file names, 
rock unit, date, and 50k mapsheet 
 

Lithology Samples  
 

lithology rock type Location of lithologic observation 
(points) 
 

UTM coordinates (NAD83), station number, 
map unit, rock type, colour, grain size, texture, 
metamorphic indicators, mineralization. 
 

Analytical Samples samples analysis type Location of samples collected 
(points) 
 

UTM coordinates (NAD 83), station number, 
type of analysis 

Structural 
Measurements 
 

structures type of structural 
element 

Point location of all structural 
measurements  

UTM coordinates (NAD83), station number, 
structural element, azimuth and dip (or 
plunge) of structural element 



 

4.02 Bedrock Geology 
 

The first nine themes display geological line and polygon information as interpreted and 

shown on the new bedrock geology map of Glenlyon map area (Colpron et al., 2001 – 

Open File 2002-9).  The mapping was done at a scale of 1:125 000 on 1:50 000 scale 

base maps.  The last theme (Bedrock Geology 1999) is from the 1:250 000 scale Yukon 

Digital Geology compilation (Gordey and Makepeace, 1999).   

 

All the bedrock geology theme shapefiles are found in the 

..\data\gis_projects\esri\bedrock_geol folder.  The corresponding MapInfo tables are found 

in the ..\data\gis_projects\mapinfo\tables folder. 



 

…4.02 Bedrock Geology 

Theme Name File Name 
(*.shp, *.tab) 

ArcExplorer 
Map Tip 

Description Attribute Data 

     
Structure Symbols  
(only visible at less than  
1:250 000 scale) 

structure_ 
symbols 

structural feature selected structural symbols scaled 
for 1:125 000 scale map (bedding, 
foliations, fold axes and lineations) 
 

Structural feature type and GeoFIELD symbol 
name 

Structure Text (only visible 
at less than 1:250 000 scale;  
not available in ArcExplorer) 
 

structure_text N/A Dip and plunge text for structural 
symbols scaled for 1:125 000 scale 
map. 

Dip or plunge 

Contacts 
 

contacts N/A Approximate and inferred 
geological contacts (lines) 
 

Reliability (approximate or inferred) 

Faults 
 

faults name Approximate and inferred fault 
contacts (lines) 
  

Fault type (thrust, strike-slip, normal), name, 
and reliability (approximate or inferred) 

Fault Symbols 1 
 

fault_symbols_ 
teeth 

N/A Thrust fault teeth and normal fault 
symbols sized for 1:125 000 scale 
map (polygons) 
 

N/A 

Fault Symbols 2 fault_symbols_ 
lines 

N/A Normal fault symbols for 1:125 000 
scale map (lines) 

N/A 

Cross Sections xsection_lines name Lines of cross section displayed on 
Open File 2002-9 

Name (eg A-A’) 

Data Sources data_sources data source Approximate extents of various 
data sources used to interpret 
geology (1: 250 000 scale) 

Data source reference 

 
Bedrock Geology 2002 
 

 
geology 

 
map unit 

 
Geology polygons from 1: 125 000 
scale 2002 mapping program 
(Open File 2002-9)  

 
Map unit designator, unit name, age (numeric 
and period), rock class (layered or intrusive), 
setting (basin, fault zone, trough), formation, 
legend text, terrane, assemblage, legend 
colours. 
 

Bedrock Geology 1999 geology_ydg map unit (tgi_unit) Geology polygons from 1:250 000 
scale Yukon Digital Geology (1999) 
compilation.  Provided as general 
reference for surrounding area only 
-  Units along boundaries of 2002 
extents may not match. 

Regional unit, tectonic unit, terrane, era, 
period, rock class, rock type, numeric age, 
reassigned map unit (tgi_unit). 



 

4.03 Yukon MINFILE  
 

This theme displays point locations of all Yukon MINFILE occurrences in the Glenlyon study area.  All 

information is extracted from Yukon MINFILE (2002).  The location of most MINFILE occurrences is very 

approximate, on the order of 500 to 1000 m. 

 

The MINFILE theme shapefile is found in the ..\data\gis_projects\esri\bedrock_geol folder.  The 

corresponding MapInfo table is found in the ..\data\gis_projects\mapinfo\tables folder. 

 

Theme Name File Name 
(*.shp, *.tab) 

ArcExplorer 
Map Tip 

Description Attribute Data 

     
Minfile - Hyperlink 
 

minfile Label showing 
MINFILE No., 
name, deposit 

type, and major 
commodities 

Location of mineral occurrences 
with active hyperlinks in ArcView 
3.x and ArcMap 8.x (points) 
 

MINFILE No., UTM coordinates (NAD83), 
latitude and longitude (decimal degrees),  
deposit model, status, major commodities, 
name, hyperlink file names 
 

 

MINFILE SUMMARY TEXT FILES 

Adobe Acrobat (PDF) text files summarizing each MINFILE occurrence in more detail (including work 

history and geological setting) can be viewed within the ArcView 3.x  and ArcMap 8.x projects on this 

CD-ROM by using  the Hotlink or Hyperlink tools respectively (for more information see sections 3.2 

and 3.3).  The text files are from the Yukon MINFILE, 2001.   

 

If the user does not have access to Arcview 3.x or ArcMap, the individual text files can also be opened 

directly in Acrobat Reader from the ..data\gis_projects\esri\hyperlinks\minfile folder.   



 

4.04 Isotopic Age Dates  
 

This theme displays the point locations of specimens that have been dated using isotopic age dating 

techniques (Ar/Ar, K/Ar, and U/Pb).  Detrital U/Pb dates and locations of pending dates are also included.  

Basic information is from the new Yukon Age 2002 CD (Breitsprecher et al., 2002), with modifications 

and additions of unpublished and pending data by M. Colpron and J.K. Mortensen.  More detailed 

documentation for published geochronology (descriptions, interpretations and Concordia diagrams) are 

available on the Yukon Age CD (Breitsprecher et al., 2002).     

 

All locations for samples taken by the Yukon Geology Program (sample numbers beginning with 98, 99, 

00, 01, or 02)  were derived from GPS readings of UTM coordinates, with an accuracy on the order of 10 

m.  The locations of all other samples are very approximate, with an accuracy on the order of 100 m.   

 

The theme shapefile is found in the ..\data\gis_projects\esri\bedrock_geol folder.  The corresponding 

MapInfo table is found in the ..\data\gis_projects\mapinfo\tables folder. 

 

 

Theme Name File Name 
(*.shp, *.tab) 

ArcExplorer 
Map Tip 

Description Attribute Data 

     
Geochronology 
 

geochron Age (ma) Location of isotopic age dates 
(points) 
 

Sample no., age determination and error, 
dating method, mineral dated, lithology, map 
unit, interpretive notes, references, UTM 
coordinates (NAD83) 
 

 



 

4.05 Fossils  
This theme displays the point locations of fossil specimens.  Fossil information was extracted from 

Poulton et al. (1999) in the Yukon Digital Geology compilation (Gordey and Makepeace, 1999) and 

supplemented by additional collections by M. Colpron. 

 

All locations for samples taken by the Yukon Geology Program (sample numbers beginning with 98MC 

or 99MC) were derived from GPS readings of UTM coordinates, with an accuracy on the order of 10 m.  

The locations of all other samples are very approximate; some samples are likely misplotted by a few 

kilometers.   

 

The theme shapefile is found in the ..\data\gis_projects\esri\bedrock_geol folder.  The corresponding 

MapInfo table is found in the ..\data\gis_projects\mapinfo\tables folder. 
 
Theme Name File Name 

(*.shp, *.tab) 
ArcExplorer 

Map Tip 
Description Attribute Data 

     
Fossils 
 

fossils taxa Location of fossil specimens 
(points) 
 

Sample no., GSC locator no., taxa, age, data 
source, UTM coordinates (NAD83), map unit. 
 

 

      



 

4.06 Surficial Geology Field Data 
 

These three point themes represent the locations of field sites visited by surficial geologists during the 2002 till 

sampling program.  359 till samples were taken.  Clast lihology analysis was completed for 30 of the till samples, 

mostly in the Clear Lake area (105L/14).  The shapefiles for surficial stations and till clast lithologies were 

derived from the surficial geology database (..\data\databases\ms_access\field_data\surficial_geol\surficial.mdb).  

Information for the surficial photos shapefile was compiled from personal communications from the surficial 

geologists.  All locations were derived from GPS readings of UTM coordinates, with an accuracy on the order of 

10 m. 

 

The theme shapefiles are found in the..\data\gis_projects\esri\surficial_geol folder.  The corresponding 

MapInfo tables are found in the ..\data\gis_projects\mapinfo\tables folder. 

 
 

Theme Name File Name 
(*.shp, *.tab) 

ArcExplorer 
Map Tip 

Description Attribute Data 

     
Surficial Stations 
 

surficial_samples station number Location of field stations (points) 
 

UTM coordinates (NAD83), nts sheet, 
geologist, station number, date, elevation, 
slope, aspect, vegetation, drainage, till 
characteristics (matrix & clasts), soil profile, 
sample medium 
 

Till Clast Lithology 
 

till_litho sample number Location of till samples with clast 
lithology analysis results 

Sample no., UTM coordinates (NAD83), 
percentages of clasts in various lithological 
classes (metamorphic, intrusive, volcanic, 
sedimentary, chert, limestone, conglomerate, 
quartz, oxidized clasts) 
 

Surficial Photos - 
Hyperlink 

surf_photos caption Location of field photographs, with 
active hyperlinks in ArcView 3.x 
and ArcMap 8.x (points) 
  

Sample no., UTM coordinates (NAD83), 
caption, landform, hyperlink file name  



 

4.07 Surficial Geology Map Units 
 

This polygon theme is compiled from previous 1: 100 000 scale surficial geological mapping done by the 

Geological Survey of Canada (GSC).  Digital files were obtained from the GSC for the Carmacks map 

area (115I – GSC Maps 1878A and 1879A; Jackson, 1997a,b).  No digital files existed for the Glenlyon 

map area (105L – GSC Maps  1786A -1789A; Ward and Jackson, 1993a-d) so map units were digitized 

by hand from the paper maps at 1: 100 000 scale.   

 

Due to inherent digitizing inaccuracies and the necessity of combining data from different formats and 

from different authors, there are some minor discrepancies in the spatial extents of this data.  As a result, 

some polygons do not line up across map sheet boundaries.  Overall, however, the dataset is extremely 

useful for identifying major areas that have been subject to specific glaciations, and areas covered by 

specific surficial materials.   

 

The theme shapefile is found in the..\data\gis_projects\esri\surficial_geol folder.  The corresponding 

MapInfo table is found in the ..\data\gis_projects\mapinfo\tables folder. 

 

Theme Name File Name 
(*.shp, *.tab) 

ArcExplorer 
Map Tip 

Description Attribute Data 

     
Surficial Geology 
 

surf_geol Map unit and 
glaciation 

surficial geology unit polygons 
 

Map unit, original source, age, glaciation, 
surficial material origin, descriptive legend 
notes 
 

 



 

4.08 Till Geochemistry 
The results of the till geochemistry laboratory analysis are presented as a series of 40 themes – one for 

each element analyzed (Ag, Al, As, Au, B, Ba, Bi, Cd, Co, Cr, Cu, Fe, Ga, Hg, K, La, Mg, Mn, Mo, Na, Ni, 

Os, P, Pb, Pd, Pt, S, Sb, Sc, Se, Sr, Te, Th, Ti, Tl, U, V, W and Zn). Each of the 40 geochemistry themes 

are generated from the same single shape file (till_geochem.shp).  Each data point can be linked to the 

Till Geochemistry table of the Surficial Database.  

  

In ArcView  and ArcMap, the geochemistry results are displayed in percentile classes (the values of 

the class breaks can be reviewed at ..data\databases\ms_excel\surficial_geol/geochem_percentiles.xls).  

Each element (except for B, Os, Pd, and Pt, which do not have enough data variability to create 

percentile classes) is displayed with the same eight percentile classes to allow relative comparisons of 

anomalous results between elements.  Percentile calculation statistics were performed on the entire till 

geochemistry sample set, with duplicate samples excluded.  Field duplicates and control standards were 

used to evaluate the quality of the geochemical analyses.  The results of these quality determinations are 

presented by Bond and Plouffe (2002). 

 

ArcExplorer does not support the display of percentile classes, so in the ArcExplorer  projects, the 

geochemistry is displayed in eight classes.  The values of the class breaks however, are different for 

each element.  The actual value for a particular sample for the element dispayed in a theme (in %, ppm 

or ppb depending on the element) is displayed in ArcExplorer as a Map Tip when the cursor is passed 

over a sample.   

 

Due to time constraints, the 40 till geochemistry themes are not presented in MapInfo.  Instead, a 

single till geochemistry layer is provided, which can be browsed or thematically displayed for any 

element.   



 

 

…4.08 Till Geochemistry 

 

The theme shapefile is found in the..\data\gis_projects\esri\surficial_geol folder.  The corresponding 

MapInfo table is found in the ..\data\gis_projects\mapinfo\tables folder. 

 
 
Theme Name File Name 

(*.shp, *.tab) 
ArcExplorer 

Map Tip 
Description Attribute Data 

     
Till geochem (– Ag, 
Al, As, Au, B, Ba…) 
 

till_geochem Analysis result for 
element specified 
in theme name, in 

ppb, ppm, or % 

Locations of laboratory analysis 
results for till geochemistry (points) 
 

Sample no., analysis results for all elements 
analyzed, sample weight, UTM coordinates 
(NAD83) 
 

 

 



 

4.09 Regional Geochemical Survey (RGS): 
 

This theme consists of 1199 stream sediment geochemical sample points that have been collected under the 

Geological Survey of Canada’s National Geochemical Reconnaissance Program with funding primarily from 

DIAND and YTG under cooperative agreements with the GSC.  Analysis results are present for a variety of 

elements.   

 

Further documentation on analysis and statistical methods, detection limits and measurement units are available 

from http://www.geology.gov.yk.ca/gallery/rgs/documentation.htm .  The data was compiled by Daniele Heon, 

2002.  

 

The RGS theme shapefile is found in the ..data\gis_projects\esri\surficial_geol folder.  The corresponding 

MapInfo tables are found in the ..\data\gis_projects\mapinfo\tables folder. 

 

Theme Name File Name 
(*.shp, *.tab) 

ArcExplorer 
Map Tip 

Description Attribute Data 

     
RGS 
 

rgs Sample number Locations of laboratory analysis 
results for stream sediment 
geochemistry (points) 
 

Sample no., analysis results for all elements 
analyzed, sample weight, UTM coordinates 
(NAD83), drainage characteristics. 
 

 
 
 

 

http://www.geology.gov.yk.ca/gallery/rgs/documentation.htm


 

4.10 Topographic Features 

 

These three themes display line and polygon base map topographic features (contours, lakes, and 

rivers) in the Glenlyon area.  These themes are highly generalized and are only intended to provide a 

very basic orientation for the topographic features of the area.   

 

All topographic themes are at 1:1 000 000 scale and were extracted from ESRI Digital Chart of the 

World.  Please note that because of the large scale of this data set, the topographic data does not match 

perfectly with the rest of the themes, which are mostly at a scale of 1:50 000.   This can be demonstrated 

when the lakes are shown to be offset on top of the LandSat images.   

 

Due to NRCan copyright restrictions, it is not possible to distribute 1:50 000 scale topography, which 

portrays the topography far more accurately.  If users own the more detailed 1:50 000 scale digital 

topographic data, they are encouraged to add these files to the interactive map projects instead of using 

the topographic themes provided on this CD. 

 

The topographic theme shapefiles are found in the ..data\gis_projects\esri\base_map folder.  The 

corresponding MapInfo tables are found in the ..\data\gis_projects\mapinfo\tables folder. 



 

…4.10 Topographic Features 

 
 
 
 
Theme Name File Name 

(*.shp, *.tab) 
ArcExplorer 

Map Tip 
Description Attribute Data 

     
Contours 
 

contours elevation Topographic contours (lines) 
 

Elevation (1000 ft intervals) 

Lakes 
 

lakes N/A Major waterbody polygons (lakes 
and large rivers) 
  

N/A 

Rivers 
 

rivers N/A Major rivers and streams, and 
outlines of major water bodies 
(lines) 

N/A 

Roads roads name Major highways, secondary roads, 
streets and limited use roads. 

Road type, name, highway number, surface 
description, number of lanes, accuracy.  



 

4.11 Other Base Map Layers 
 

The first five of the following base map themes (neatlines, image mask and UTM grid) were digitized in house to 

fit with the 1: 50 000 scale boundaries and coordinate systems. 

 

The roads theme is part of the Updated Road Network (URN) survey recently done by Natural Resources 

Canada.  All roads were driven with a GPS, and are reported to have 5 m accuracy.  They align well with the 

LandSat 7 image. 

 

The first nations theme shows A and B block settlement lands at 1:250 000 scale.  The data was compiled by 

Renewable Resources (Yukon Environment) in the year 2000 

(http://www.renres.gov.yk.ca/pubs/rrgis/govdata.html).  Site specific and community lands are not included.  The 

theme is intended only to provide a general view of the distribution of major settlement lands in the study area.  

Legal records and higher quality settlement land data can be obtained from DIAND Claims and Indian 

Government (for Interim Protected unsurveyed/unfinalized lands) and Natural Resources Canada Legal Surveys 

Division (for surveyed blocks).  All surveyed blocks are delineated by recent cutlines on the ground. 

 

With the exception of the Geol Neatline theme (which is located in the ..data\gis_projects\esri\bedrock_geol 

folder), the following theme shapefiles are found in the ..data\gis_projects\esri\base_map folder.  The 

corresponding MapInfo tables are found in the ..\data\gis_projects\mapinfo\tables folder. 
 
 
 
 
 
 
 
 

http://www.renres.gov.yk.ca/pubs/rrgis/govdata.html


 

…4.11 Other Base Map Layers 

 
 
 
Theme Name File Name 

(*.shp, *.tab) 
ArcExplorer 

Map Tip 
Description Attribute Data 

     
Neatline 
 

neatline N/A Polygon boundary for full extent of Glenlyon study area 
 

N/A 

Geol Neatline 
 

geol_neatline N/A Polygon boundary for extent of 2002 bedrock 
geological mapping 
  

N/A 

Image Mask 
 

neatline_mask N/A Polygon “donut” which, when displayed as a white 
polygon, will mask or cover imagery extending beyond 
the boundaries of the neatline.   

N/A 

Utm Grid utm_grid N/A 5000 m UTM (Nad 83, Zone 8) grid 
 

UTM metres N or E 

50K Mapsheets 50K_sheets 50K map number Polygon outline of 1:50 000 NTS map sheets Map number 

Roads roads name Major highways, secondary roads, streets and limited 
use roads (1:50 000 scale) 

Road type, name, highway 
number, surface 
description, number of 
lanes, accuracy.  

First Nations Settlement 
Lands 

first_nations first nation 
(abbreviated) 

Category A and B settlement lands (1:250 000 scale) 
for Little Salmon Carmacks First Nation (LSC), Selkirk 
First Nation (SK) 

Category, block number, 
first nation 



 

4.12 Geophysical Images 
 

These seven themes are raster images of regional aeromagnetics for the Glenlyon area.  To create a 3D 

effect, the geophysical data are fused with a panchromatic hill-shaded 1:50 000-scale Digital Elevation 

Model (DEM).  The resolution of the final images is 30 m.   

 

The geophysical data were provided by the Geophysical Data Centre of the Geological Survey of 

Canada (note that this data is under crown copyright and as such should not be redistributed in any form 

to third parties).  The DEMs were supplied by Geomatics Yukon.  Geophysical data processing was 

performed by Carmel Lowe (GSC); image integration and processing was performed by Peter von Gaza. 

 

The images were originally prepared in TIFF (*.tif) format and were converted into JPEG (*.jpg) format to 

create smaller file sizes.  They are still relatively large files however, so users are cautioned when 

displaying these themes in the interactive map projects.  Depending on the speed of your computer, 

display of the images could be slow.   

 

World files (*.jpw for ESRI gis products) and table files (*.tab for MapINFO) are supplied for image 

georeferencing.   

These files and the images themselves are found in the ..data\gis_projects\esri\raster\geophys_dem folder.   



 

…4.12 Geophysical Images 

 
 
 
 
Theme Name File Name 

(*.jpg, *.tab) 
Description 

   
Gravity 1 gravcarmeltopo_glenlyon  

Gravity 2 
 

gravpvgtopo_glenlyon  

Horiz Gradient 
Mag 

horzgradmagtopo_glenlyon Horizontal gradient regional aeromagnetic 

Vert Gradient 
Mag 

vertgradmagtopo_glenlyon Vertical gradient regional aeromagnetic 

Total Mag magtopo_glenlyon Total field regional aeromagnetic 

Mag Slope 
Gradient 

mag_slope_gradient_glenlyon Slope gradient regional aeromagnetic 

Mag Equal 
 

magequaltopo_glenlyon  

 
 



 

4.13 LandSat Images 
 

These two themes are raster images of LandSat 7 data for the Glenlyon area. To create a 3D effect, the 

LandSat imagery was fused with a panchromatic hill-shaded 1:50 000-scale Digital Elevation Model 

(DEM).  The resolution of the final LandSat images is 15 m.  Both the DEM and the LandSat imagery 

were supplied by Geomatics Yukon and processed by Peter von Gaza.  The images were originally 

prepared in TIFF (*.tif) format and were converted into JPEG (*.jpg) format to create smaller file sizes.  

They are still relatively large files however, so users are cautioned when displaying these themes in the 

interactive map projects.  Depending on the speed of your computer, display of the images could be 

slow.   

 

World files (for ESRI gis products) and tab files (for MapINFO) are supplied to ensure correct 

georeferencing of the images.  The images, world files and MapInfo tables are found in the 

..data\gis_projects\esri\raster\satellite_dem folder. 

 

Two different band-colour combinations are provided, which portray the study area quite differently.  321 

bands are true RGB colour bands, while the 543 bands are infrared bands which provide more powerful 

vegetation discrimination. 

 

Theme Name File Name 
(*.jpg, *.tab) 

Description 

   
LandSat 543 
 

3_543fusex 

topomult90_ glenlyon.jpg 

 

False colour (infrared) - LandSat image (bands 5,4,3) fused with 15 m 
panchromatic and  hillshaded digital elevation model (DEM).   
 

Landsat 321 
 

321fusetopo_ glenlyon.jpg 

 
True colour (RGB) - LandSat image (bands 3,2,1) fused with 15 m panchromatic 
and  hillshaded digital elevation model (DEM) 



 

 

5.0 Published Maps and Reports 

 

Several publications are included on this CD.  These include reports, maps and unpublished figures containing 

background information about the Glenlyon study area.  They are provided in Adobe Portable Document 

Format (*.pdf) and require Acrobat Reader 3 or later to view (Acrobat Reader 5 is provided on this CD).   

 

To view any of these publications, go to 

the Publications panel, select a 

publication type and a specific item from 

the list.   

 

The button at the lower right corner of 

the Publications panel will launch the 

installation of the free Adobe Acrobat 

Reader 5 software provided on this 

CD. 

 

The publications are divided into four categories: Yukon Exploration and Geology papers, Yukon Geology 

Program bedrock geology maps, Geological Survey of Canda surficial geology maps, and unpublished figures. 



 

… 5.0 Published Maps and Reports 

5.1 YEG Papers  

 

Geological reports published in the Yukon Exploration and Geology (YEG) series by the Yukon Geology 

Program.  

 

 

 

 

 

 

 

 

 

 

 

List Name 
 

Description 
 

File Name (in folder 
..publications\adobe_pdfs\yeg_papers) 

   
Bond & Plouffe, 2003 Glenlyon till geochemistry (105L & 115I) Bond_YEG02.pdf 
Colpron, 1999a Little Kalzas Lake geology (105L/13) Colpron_YEG98_1.pdf 
Colpron, 1999b Little Salmon Lake new mineral occurrence (105L/2) Colpron_YEG98_2.pdf 
Colpron & Reinecke, 2000 Little Salmon Range coherent stratigraphy 

(105L/1,2,7) 
Colpron_YEG99.pdf 

Colpron, 2001 Glenlyon YTT volcanic geochemistry (105L) Colpron_YEG00.pdf 
Colpron & YTWG, 2001 YTT stratigraphic comparison Colpron_YTWG_YEG00.pdf 
Colpron et al., 2003 Glenlyon bedrock geology (105L & 115I) Colpron_YEG02.pdf 
Gladwin et al., 2002 Geology, YTT-Cassiar contact (105L/1) Gladwin_YEG01.pdf 
Gladwin et al., 2003 Geology, Truitt Creek (105L/1) Gladwin_YEG02.pdf 
Nelson et al., 2000 YTT preliminary stratigraphic comparison Nelson_YEG99.pdf 



 

5.2 YGP Bedrock Geology Maps  

Bedrock geology maps published by the Yukon Geology Program (YGP) as Indian and Northern Affairs Canada 

(INAC) Exploration and Geological Services Division (EGSD) Open File Maps. 

 

List Name 
 

Description 
 

File Name (in folder 
..publications\adobe_pdfs\y
gp_maps) 

   
Little Kalzas Lake (105L/13), 1:50 000 EGSD Open File 1998-3 (Colpron, 1998) OF1998_3.pdf 
Little Salmon Lake (105L/1,2,7), 1:50 000 EGSD Open File 2000-10 (Colpron, 2000) OF2000_10.pdf 
Glenlyon (105L) & NE Carmacks (115I), 
1:125 000 

EGSD Open File 2002-9 / GSC Open File 1457 
(Colpron et al., 2002) 

OF2002_9.pdf 

Truitt Creek (105L/1), 1:50 000 EGSD Open File 2002-5 (Gladwin et al., 2002) OF2002_5.pdf 
MINFILE (105L) 1:250 000 Yukon MINFILE Mineral Occurrence Map 105L minfile_105L.pdf 
MINFILE (115I) 1:250 000 Yukon MINFILE Mineral Occurrence Map 115I minfile_115I.pdf 

 

5.3 GSC Surficial Geology Maps 

These maps were published by the Geological Survey of Canada (GSC) by Ward and Jackson (1993)  

at 1:100 000 scale.  The maps are scanned images and are provided as a background reference to the surficial 

geology shapefiles (which were digitized from these maps) on this CD.  The maps were not scanned at high 

resolution, so they may appear pixelated when zoomed in too close. 

 

List Name 
 

Description 
 

File Name (in folder 
..publications\adobe_pdfs\gsc_surficial_maps) 

   
NW 105L - Needlerock Ck GSC Map 1786A  1786A.pdf 
NE 105L - Wilkinson Range GSC Map 1787A 1787A.pdf 
SW 105L - Afe Ck GSC Map 1788A 1788A.pdf 
SE 105L - Telegraph Mtn GSC Map 1789A 1789A.pdf 

 



 

 

5.4 Unpublished Figures 

Various background figures which have not been published, or which come from parts of other publications. 

 

List Name 
 

Description 
 

File Name (in folder 
..publications\adobe_pdfs\unpub_figs) 

   
Clear Lake Till Clast Lithology Detailed geology (1:10 000) with till lithology clrlk_till_litho.pdf 
Glenlyon Detrital Ages Detrital ages in OF 2002-9 study area detrital_ages.pdf 
Glenlyon Fossils Fossils in OF 2002-9 study area fossils.pdf 
Glenlyon Geochronology Geochronology in OF 2002-9 study area geochron.pdf 
Glenlyon MINFILE MINFILE in OF 2002-9 study area minfile.pdf 
YTT Correlations, 2001 Yukon-Tanana Working Group compilation, 2001 YTTcorr2001.pdf 

 

 



 

 

6.0 Field Databases 

 

The databases assembled during the Glenlyon field mapping program are included on this CD. Both the bedrock 

geology and surficial geology databases are provided in MS Excel 95 (*.xls) and MS Access 2000 (*.mdb) 

formats found in the ..data\databases folder. 

 

To most easily view the data, MS Access 2000 software or above is 

required.  Open the Databases panel (shown at the right) from the home 

interface, and select the desired database.  

 

Advanced MS Access  users can perform customized queries and 

searches and reports on the databases.  Consult the on-line help for 

guidance on performing database queries and reports. 

 

To save any changes such as custom queries or reports to the databases, the database files must be 

copied to a hard drive and the read-only property must be removed from the files.  

   

For users without MS Access 2000, all data tables from the Access  databases were exported to MS 

Excel.  The resultant *.xls files can be found in the ..\data\databases\ms_excel\  folder.  

 

 

 



 

6.1 Bedrock Geology 
The bedrock geology database contains all the field information recorded by the bedrock geologists.  During the 

2002 field season, data was collected in the field using Palm OS handheld devices, and the results were 

downloaded daily to a GeoField database – the Yukon Geology Program’s customized MS Access 2000 field 

database application. Data collected between 1998 and 2001, was originally entered into a FieldLog database 

and subsequently imported into GeoField.  Data includes information on stations, lithologies, structural 

measurements, samples and photos for 1818 stations that were visited in the field by various geologists since 

1998. It also includes selected data compiled from previous maps and assessment reports. 

Seven related data tables make up the bedrock geology database.  The data from all the tables can be 

viewed together in a user friendly form named Glenlyon Bedrock Geology Field Data (see next page).  Upon 

opening the database (located at ..\data\databases\ms_access\field_data\bedrock_geol\bedrock.mdb), this form 

will automatically be displayed.  (If the form does not display, go to Forms, and open the “Data Entry” form in the 

main database window.)   

 

Bedrock Geology Database Tables: 

 

Table Name Description 
MapUnits Descriptions of lithological map units, as used in OF Map 2002-9 

Station Station location information 

Structure Structural measurements at a station 

Photo Catalogue of photographs at a station 

Lithology Lithological descriptions at a station 

Sample Samples collected at a station 

Analysis Type Analysis types selected for specific samples 



 

…6.1 Bedrock Geology 

Upon opening the database you will encounter the following error message: 

 
Click OK to enter the GeoField form. 

 

To navigate between records in the MS Access  form, use the Record Selectors 

( ) at the bottom of the form, or use the arrow keys ( ) within the form.  

Note that a single station can have multiple lithology, structure or photo records.  



 

6.1.1 GeoFIELD 

 
GeoField is a data management system which is designed to facilitate data entry/recording and 

the production of geologic maps while in the field. GeoField is simply a customized MS Access 

2000 database which interacts with AutoCAD Map 2000  to allows digitizing and plotting of 

station locations and structural data using a Visual Basic for Applications interface.  

 

A blank GeoFIELD database (..\software\geofield\geoFIELD_v2_2_blank.mdb) is included on the 

CD, along with a full manual for its use.  Users are welcome to use it for their own field data 

management.   

 

For more information on GeoField see the manual (..\software\geofield\geoFIELD 

Manual_v2_2.pdf), visit the Yukon Geology Program website (www.geology.gov.yk.ca) or contact 

Panya.Lipovsky@gov.yk.ca or Maurice.Colpron@gov.yk.ca.  

 

 

 

www.geology.gov.yk.ca


 

6.2 Surficial Geology 
The surficial geology database (..\data\databases\ms_access\field_data\surficial_geol\surficial_geol.mdb)  

contains the field information recorded by surficial geologists during the till sampling program.  Surficial geology 

data was collected in the field using IPAQ handheld devices, which stored information in shapefile DBASE 

format directly in the field.  The DBASE files were then imported into Access for ease of viewing.   

 

The surficial geology database provides information on station and site characteristics, till geochemistry, till 

properties, clast lithology and matrix descriptions for 359 samples.  It also contains geochemical analysis results 

for the till samples.   

 

Four related data tables (see below) make up the surficial database.  The data from the first three tables can be 

viewed together in a user friendly form, named Till Sample Data (see next page).  This form will automatically 

display upon opening the database.  (If the form does not display, go to Forms, and open the Till Sample Data 

form in the main database window.)  The data in the Geochem_percentiles table is given as a reference only.  

The percentile values were used to delineate classes for symbolizing the legends in the interactive maps.   

   

Surficial Geology Database Tables: 

 

 

 

 

 

 

 

Table Name Description 
2002 Field Data sample data collected in the field 

Lithology till clast lithology analysis results 

Till Geochemistry till geochemistry analysis results 

Geochem_percentiles percentile classes used to symbolize geochemistry legends for interactive maps 



 

… 6.2 Surficial Geology 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Use the Record Selector arrows at the bottom of the window or the Find button to navigate between sample 

numbers.   



 

7.0 Photo Gallery  

 

Bedrock geology field photos are included on the CD to provide an opportunity for users to closely examine the 

various rock types encountered in the study area.  Surficial geology photos have also been included to 

showcase the Glenlyon area landscape and its representative landforms.   

 

The photos are provided in JPEG (*.jpg) format, at a resolution of 100 dpi (approximately 800 x 550 pixels) and 

are located in the ..\data\gis_projects\esri\hyperlinks\photos folder. 

 

The photos can be accessed from the CD home panel, by opening the Photo Gallery interface.  This is a 

customized photo viewer, designed by Peter Von Gaza.  Using this interface, the bedrock photos can be 

searched by station number, map unit, terrane, structure and mineralization.  The surficial photos can be 

searched by landform.  Scenic photos, and photos of the camp and crew are also included.  When a category is 

selected, a list will be generated listing the names of the digital photo files in a particular category.  When a 

single file name is selected from this list, an enlarged view of the photo will appear, with its associated caption. 

 

Alternatively, the photos can be viewed through hyperlinks in the ArcView 3.x and ArcMap 8.x interactive map 

projects (see section 3.2 and 3.3). The hyperlink will open the image in the default image viewing software, such 

as Microsoft Photo Editor, Corel PhotoPaint, or Adobe PhotoShop. 

 

 

 



 

 

8.0 Recommended Citation 

 
Colpron, M., Bond, J.D., Lipovsky, P.S., Gladwin, K., Gordey, S.P., Murphy, 

D.C., Nelson, J.L., Plouffe, A., Roots, C.F., and Abbott, J.G., 2003, Digital 

compilation of bedrock geology and till geochemistry, Glenlyon (105L) and 

eastern Carmacks (115I) map areas, Yukon Territory; Exploration and 

Geological Services Division, Yukon Region, Indian and Northern Affairs 

Canada, Open File 2003-7(D) and Geological Survey of Canada Open File 

1561. 



 

 

9.0 Other Geoscience Information and Sales 

Yukon Geology Program: 

Exploration and Geological Services Division, Yukon Region, Indian and Northern Affairs Canada publishes 

Yukon Geology Program publications. Copies of this CD-ROM and other Yukon Geology Program publications 

are available at the address below. 

Geoscience Information and Sales 
c/o Whitehorse Mining Recorder 
102-300 Main Street 
Whitehorse Yukon Y1A 2B5 
Ph. (867) 667-3266 
Fax. (867) 667-3267 
Email: geosales @inac.gc.ca 

 

Yukon Geology Program also distributes publications in digital format.  To download publications free of charge 

visit:  http://geology.gov.yk.ca/ .  

 

Geological Survey of Canada (Vancouver): 

General Information: 
 
Geological Survey of Canada 
101-605 Robson St. 
Vancouver, British Columbia 
V6B 5J3 
http://www.nrcan.gc.ca/gsc/index_e.html 

 
 
Maps and Publications Sales: 
Phone 1 - 604 - 666-0271 
Fax 1 - 604 - 666-1337 
http://www.rodus.com/shop/ 

 

www.geology.gov.yk.ca
http://www.nrcan.gc.ca/gsc/index_e.html
http://www.rodus.com/shop/
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